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QUESTION 1:

You are a BizTalk Server administrator for Certkiller . BizTalk Server 2000 is installed on
one computer that is responsible for document receive, messaging, and orchestration
processes.

Your BizTalk Server system receives invoices from suppliers as inbound documents, maps
each invoice to an outbound document, and posts each invoice to an accounting system for
payment processing. The BizTalk Server system uses a complex map to convert inbound
documents to outbound documents, and this process causes a significant slowdown in the
performance of the BizTalk Server computer. During this process, CPU usage is 55
percent.

You need to improve the speed of the document process without adding any additional
servers to your network. You need to change the BizTalk Server configuration to
accomplish this task.

What should you do?

A. Increase the maximum number of receives function threads.
B. Increase the maximum number of worker threads.

C. Decrease the maximum number of receives function threads.
D. Decrease the maximum number of worker threads.

Answer:

QUESTION 2:

You are the BizTalk Server administrator for Certkiller . Certkiller recently implemented a
large integration system with its trading partners.

You are working on business-to-business (B2B) integration with a new trading partner.
You need to confirm the arrival of the test business document from the trading partner's
system. You delegate this responsibility to a newly hired BizTalk Server administrator. The
new administrator receives the message shown in the exhibit when attempting to log on to
BizTalk Document Tracking.
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You are able to log on successfully. You need to ensure that the new administrator can use
BizTalk Document Tracking to confirm the arrival of the document to Certkiller 's network.
What should you do?

A. Set up a Microsoft SQL Server login account for the new administrator, select Windows
Authentication in the SQL Server Login Properties dialog box, and grant access privileges in the
Tracking database.

B. Add the new administrator's user account to the BizTalk Server Administrators group.

C. Add the new administrator's user account to the BizTalk Server Report Users group.

D. Add the new administrator's user account to the Power Users group.

Answer:

QUESTION 3:

You are the BizTalk Server administrator for Northwind Traders. Northwind Traders has
established business-to-business (B2B) integration with its trading partners. BizTalk
Server 2000 is operating on one computer, and Microsoft SQL Server is operating on a
separate computer. Northwind Traders receives a large number of customer purchases
operating on a separate computer. Northwind Traders receives a large number of customer
purchase order documents. These documents are in XML format.

You trading partners want to confirm the receipt of important purchase order documents.
The trading partners provide you with purchase order numbers, part number, and

quantity of items in the order. You enable tracking at the document level and field level.
After enabling this tracking, you discover that a large amount of data is being written to
the hard disk on the SQL Server computer, and the size of the Tracking database increases
by 40 MB per day.

You need to manage your hard disk resources while maintaining document and field
tracking functionality and optimizing system performance. What should you do?
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A. Set up replication and SQL Server Agent jobs to selectively remove transactions from the
Tracking database periodically.

B. Enable the Truncate log on checkpoint feature for the Tracking database.

C. Increase the cache refresh interval for the Messaging Management object.

D. In the BizTalk Server group properties, enable logging for MIME-encoded messages.

Answer:

QUESTION 4:

You are a BizTalk Server administrator for Certkiller . The company uses BizTalk Server
2000 for enterprise application integration (EAI). The architecture is configured as shown
in the exhibit.

A

Certkiller1 Certkiller2
(BizTalk Server & (BizTalk Server &
Microsoft SQL Server) corporale intranet)

Ethernet

The WebDAYV repository on Certkiller 2 is used as central repository of all specification and
map files. During non-business hours, you need to make modifications to a specification.
You use Certkiller 1 to perform the modification.

When you attempt to open the specification in BizTalk Editor by selecting Retrieve from
WebDAYV from the File menu. You receive the following error message.

"No BizTalk Server repository was found on

http:// Certkiller 2/BizTalkServerRepository/DocSpecs. Enter another server name to retry
the WebDAYV connection."

You verify that both servers are properly connected to the network and that the BizTalk
Services and Microsoft SQL Server are functioning normally.

You need to be able retrieve and modify specifications from WebDAV. What should you
do?

A. Retrieve the specification from WebDAYV by using BizTalk Editor on Certkiller 2.
B. Stop and restart SQL Server on Certkiller 1.

C. Start the Default Web Site in Internet Information Services (11S) on Certkiller 2.
D. Enter Certkiller 1 as the server name in the Retrieve from WebDAYV dialog.

Answer:

QUESTION 5:

You verify that both serves are properly connected to the network and that the BizTalk
Services and Microsoft SQL Server are functioning normally.

You need to be able retrieve and modify specifications from WebDAV. What should you
do?
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A. Retrieve the specification from WebDAYV by suing BizTalk Editor on BTServer2.
B. Stop and restart SQL Server on BTServerl.

C. Start the Default WebSite in Internet Information Services (I11S) on BTServer2.
D. Enter BTServerl as the server name in the Retrieve from WebDav. Dialog box.

Answer:

QUESTION 6:

You are the BizTalk Server administrator for Wide World Importers. Ever administrator
for Wide World Importers. Certkiller uses BizTalk Server 2000 for business process
integration. BizTalk Server 2000 runs on a single dedicated computer. Wide World
Importers and a trading partner recently initiated business-to-business (B2B) integration.
The trading partner provided a sample XML document instance containing sample data.
You need to crate specification and document definitions on your BizTalk Server
computer. When you attempt to open the XML document instance by using BizTalk
Editor, you receive the following message.

The fil2 CitempiPurchiacsOrder. aml covéd nok be property tpened.,
. Reason incorrect defination for the rock elements in schema.

e ]
When you open the same document by using Internet Explorer, you receive the results
shown in the exhibit.
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-

ol =770 sl
You need to complete setting up this specification so that you can configure the BizTalk
Messaging Service. What should you do?

A. Select the Create a new field as an element check box in the BizTalk Editor Options dialog
box and reopen the XML document instance file.
B. Import the XML document instance by using the Import option on the Tools menu in BizTalk
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Editor and save the resulting document as a specification.

C. Copy the XML document instance into the BizTalkSeverRepository/DocSpecs/Microsoft
folder.

D. The XML document is corrupt. Obtain a new clean copy from the trading partner and try
again.

Answer:

QUESTION 7:

You are the BizTalk Server administrator for Certkiller . BizTalk Server 2000 and
Microsoft SQL Server are running on a single computer. You company's trading partners
send document interchanges of sizes up to 1 MB each to your BizTalk Server computer.
The document flow is shown in the Document Flow exhibit.

i : Messaging thannel

P BizTalk Server and port N
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One of Certkiller 's business requirements is to track incoming documents in their original
data format. The current channel and message queue configurations are shown in the
Channel Properties exhibit and the Sales orderProperties exhibit. (
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You notice that the volume of interchanges coming in during peak business hours slows the
message processing by BizTalk Server 2000. You also use System Monitor and notice that
there is extremely high disk write activity during these times.

You need to improve the message processing performance while ensuring that the
documents are tracked in the original data format. You need to accomplish this goal
without adding additional hardware.

What should you do?

A. Create a scheduled application to receive the incoming files and submit the files to the
BizTalk Messaging Service by using the IInterchange interface. Use this application instead of
the receive function.

B. Select the In native format check box in the Log outbound document property in the Channel
Properties dialog box.

Select the Limit message storage to check box in the salesorder Properties dialog box and set
the value to 50MB.

C. Select the Limit message storage to check box in the salesorder Properties dialog box and set
the value to 100 MB.

D. Configure the message queue tracking by clearing the Enabled check box for the Journal
property in the salesorder Properties dialog box.

Answer:

QUESTION 8:

You are the BizTalk Server administrator for Certkiller . Certkiller uses BizTalk Server
2000 to integrate internal applications that export data in the form of comma-delimited flat
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files. Some of the interchanges post data that contain the delimiter as part of the data.
When such interchanges are posted, the following error message appears in the Event Log.
While parsing record "PurchaseOrder", the parser cannot find the required trailing
delimiter: "™ (0x000d).

While trying to process document # 1 during submission
"{8A158662-27E6-42EE-85E7-4BD16F6BF34D}", the parser component named
"BizTalk.ParserFFile.1" failed on the method "Get Next Document" with the error code
"0xc-0c01433". Possible causes are: the component found unexpected data in the incoming
stream; a document specification could not be found given the data; or an internal
component failure occurred. If this problem continues, remove this component from the
valid list of parser components or contact your system administrator.

Suspended Queue ID: "{1685BE17-B328-4481-891A-0744AD71F423}"

The parser failed to convert the document due to processing errors.

What are two likely causes of the failure of the interchange? (Each correct answer presents
a complete cause. Choose two.)

A. The node containing the fields with the delimiter as part of the data does not have an Escape
Type property and an Escape Value property associated with it.

B. The field with the delimiter as part of the data does not have a warp character associated with
it.

C. The field with the delimiter as part of the data does not have a pad character associated with
it.

D. The root node of the document specification does not have an Escape Type property and an
Escape Value property associated with it.

Answer:

QUESTION 9:

You are the BizTalk Server administrator for Certkiller . Certkiller uses BizTalk Server
2000 to integrate an existing application with a client/server application. The existing
application generates data in a flat-file format. You create an application integration
component (AIC) by using Microsoft Visual Basic. You deploy the AIC in the messaging
port to communicate with the clint/server application. The integration process runs
without errors.

To accommodate evolving business functionality, you change the document specifications
and deploy a newer version of the AIC. After you upgrade your BizTalk Server computer
the newer version of the AIC, the following error message appears in the Event Log.

This server could not create a component with the class ID
"{E4A03F00-86C4-41FF-BOFF-70AF6F6D7DCA}" for transport. Verify that this
component is properly registered. The flowing error was returned:

The server could not finish processing messaging port "AlICPort". Suspended Queue ID:
{94CC7687-DADE-4939-81B8-53B02C461FD4}"

You need to use the newer version of the AIC successfully. What should you do?

A. Delete the COM+ application and re-create it by pointing to the most recent AIC DLL.
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Reselect the AIC DLL component that has the same proglDas the primary transport in the
messaging port definition.

B. Unregistered and reregister the AIC DLL by suing regsvr32.exe.

Reselect the AIC DLL component that has the same ProglID as the primary transport in the
messaging port definition.

C. Delete all entries for the AIC DLL from the system registry and register the AIC DLL by
using regsvr32.exe.

D. Configure the AIC to run under the interactive user account.

Reselect the AIC DLL as the primary transport in the messaging port definition.

Answer:

QUESTION 10:

You are a BizTalk Server administrator for Certkiller . The company uses BizTalk Server
2000 to integrate its enterprise resource planning (ERP) applications under its
manufacturing, production, financial, and human resources departments. Each
department has its own BizTalk Server computer for running the department'’s
application. The names of the BizTalk Server computers are Manufacturing, Production,
Financial, and HR. Each department also has a computer running Microsoft SQL Server.
You need to configure the BizTalk Server computers and their corresponding SQL Server
database servers for ease of maintenance. What should you do?

A. Configure the Manufacturing and Production servers as part of one BizTalk Server group, and
configure the Financial and HR servers as part of another BizTalk Server group. Configure each
BizTalk Server group to point to separate SQL Server computers that have separate BizTalk
Messaging Management and Shared Queue databases. Configure each BizTalk Server group to
point to a single Tracking database.

B. Configure the Manufacturing and Production servers as part of one BizTalk Server group, and
configure the Financial and HR servers as part of another BizTalk Server group. Configure each
BizTalk Server group to point to separate SQL Server computers that have separate Shared
Queue databases.

C. Configure the Manufacturing and Production servers as part of one BizTalk Server group, and
configure the Financial and HR servers as part of another BizTalk Server group. Configure each
BizTalk Server to point to separate SQL Server computers that have separate instances of the
BizTalk Messaging Management, Shared Queue, and Tr4acking database.

D. Configure the Manufacturing and Production servers as part of one BizTalk Server group, and
configure the Financial and HR servers as part of another BizTalk Server group. Configure each
BizTalk Server group to point to separate SQL Server computers that have separate instances of
the Shared Queue and Tracking databases. Configure each BizTalkServer group to point to a
shared BizTalk Messaging Management database.

Answer:

QUESTION 11:
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You are a BizTalk Server administrator for Certkiller . You install BizTalk Server 2000 on a
Microsoft Windows 2000 Server computer. When you attempt to open document schemas
from both BizTalk Editor and document definitions, you observe the Retrieve from
WebDAYV dialog box shown in the exhibit. (Click the Exhibit button.)

You use Windows Explorer to verify that the document schema files are in the WebDAV
repository located on the server's hard disk. You need to be able to open the document
schemas within the Retrieve from WebDAYV dialog box.

What should you do?

A. Use Internet Information Services (11S) to navigate to the BizTalkServerRepository folder.
Enable Anonymous access permissions to the WebDav repository.

B. Use Internet Information Services (11S) to navigate to the BizTalkServerRepository folder.
Enable Read permissions to the WebDAYV repository.

C. Use Internet Information Services (11S) to navigate to the BizTalkServerRepository folder.
Enable Directory browsing permissions to the WebDAYV repository.

D. Use Internet Information Services (11S) to navigate to the BizTalkServeRepository folder.
Select the Index this resource check box for the WebDAYV repository.

Answer:

QUESTION 12:

You are a BizTalk Server developer for Certkiller . Certkiller receives purchase orders from
trading partners in standard XML format. Each purchase order contains one item record.
The purchase orders are sent to either the shipping department or the manufacturing
department for further processing, based on the category of the item. Both the shipping
application and the manufacturing application can retrieve purchase orders from a

message queue located on the BizTalk Server computer.

You want to automate the process of routing each XML purchase order document to the
appropriate message queue for further processing by the shipping application and the

manufacturing application. You create a schema as shown in the exhibit.
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The ItemCategory field will take one of the two values. The two values are Finished Goods
and Production.

You crate two message queues named FinishedGoods and production. You crate an
XLANG schedule to process the inbound purchase order document. You need to complete
the XLANG schedule to be able to route the document so that the shipping application or
the manufacturing application will continue the business process..

What should you do?

A. Use the XML Communication Wizard in the XLANG schedule drawing to expose the
ItemCategory field of the inbound purchase order message.

Add an

Action shape to implement a COM component that takes the value of ItemCagegory field and
returns the fully qualified path of the message queue.

B. Use the XML Communication Wizard in the XLANG schedule drawing to expose the Item
Category field of the inbound purchase order message.

Add an Action shape to implement a COM component that takes the value of Item Category
field and returns the fully qualified path of the message queue.

Perform appropriate data mapping.

C. Use the XML Communication Wizard in the XLANG schedule drawing to expose Item
Category field of the inbound purchase order message.

Add an Action shape to implement a COM component that takes the value of Item Category
field and returns the fully qualified path of the message queue.

Perform appropriate data mapping.

Add an Action shape to implement static Message Queuing to send the purchase order document
to the message queue.

Select Create a new queue for every instance in the Message Queuing Binding Wizard. Drag a
line from the return field that contains the queue path to the message queue pot.

D. Use the XML Communication Wizard in the XLANG schedule drawing to expose the Item
Category field of the inbound purchase order message.

Add an Action shape to implement a COM component that takes the value of Item Category
field and returns the fully qualified path of the message queue.

Perform appropriate data mapping.

Add an Action shape to implement dynamic Message Queuing to send the purchase order
document to the message queue.

Drag a line from the return field that contains the queue path to the message queue port.

Answer:

QUESTION 13:

You are a BizTalk Server developer for Certkiller . You are using BizTalk Orchestration
Designer to develop a business process that will receive purchase order from a message
queue and pass each purchase order to a COM component.

The COM component includes a Store2 method that takes two parameters. One parameter
is an XML string representing a purchase order, and the other parameter is an integer
named intFormat that selects the format of the XML string. The purchase orders handled
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by the process will always be in the same format, and the purchase order documents does
not contain format information.

You need to create a solution that passes the format to the COM component. What should
you do on the Data page?

A. Create a new constant and connect it to the intFormat field on the Store2_in message.

B. Create a new constant and connect it to the intFormat field on the Store2_out message.

C. Create a new field in the purchase order d0Oocuement received from the message queue, and
connect it to the intFormat field on the Store2_in message.

D. Create a new field in the purchase order document received from the message queue, and
connect it to the intFormat field on the Store2_out message.

Answer:

QUESTION 14:

You are a BizTalk Server administrator for Certkiller . You make extensive use of BizTalk
Orchestration Designer. You have several COM _ applications that configured to run
different XLANG schedules. You are preparing to perform a hardware upgrade on your
BizTalk Server computer. You need to perform a controlled shutdown of all XLANG
schedules that are currently running.

You decide to write a script to dehydrate all running XLANG schedules for every COM+
application. Which script should you use?

A. Dim objMgr

set objMgr=GetObject ("sked://")

objMgr. ShutdownAll

B. Dim objMgr

Set objMgr = Getobject ("sked:///")
ObjMgr.Shutdown

C. Dim objMgr

Set objMgr=GetObject ("sked:///")

Dim objlnstance in objMgr
Instance.suspendinstance objlnstance.Instance Id
Next

D. Dim objMgr

Set objMgr=GetObject (sked://I")

Dim objlnstance

For each objlnstance in objMgr

ObjMgr. Terminateinstance objlnstance.Instance Id.
Next

Answer:

QUESTION 15:
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You are a BizTalk Server developer for a bank. You need to design an XLANG schedule by
using BizTalk Orchestration Designer. The XLANG schedule must represent a financial
transaction between two accounts.

You want to enclose credit and debit operations in a Transaction shape in your XLANG
schedule drawing. You need to configure the properties of the Begging shape prior to using
the Transaction shape.

What should you do?

A. Set the transaction model to Treate the XLANG Schedule as a COM+ component.
Set the Transaction activation to Not Supported.

B. Set the transaction model to Include transactions within the schedule.

C. Set the transaction model to Treat the XLANG Schedule as a COM+ Component.

D. Set the transaction model to Treat the XLANG Schedule as a COM+ Component.

Set the transaction activation to Required.

E. Set the transaction model to Treate the XLANG Schedule as a COM+ Component.
Set the transaction activation to Requires New.

Answer:

QUESTION 16:

You are a BizTalk Server developer for Certkiller . The company is a manufacturer of
personal computers. You need to configure BizTalk Server 2000 to receive an process
customer orders for new computers.

When a customer order is received, you need each order to be divided into a list of
subitems. A purchase order for each subitem will be generated by BizTalk Server 2000 and
sent to various suppliers. The suppliers are required to confirm and respond to each
subitem purchase order.

After suppliers acknowledge all subitem purchase orders for a single customer

order, a confirmation document needs to be sent to the customer. If any supplier for one
customer order cannot fulfill subitem request, or if the customer's request is not fulfilled
within a specified time, all subitem purchase orders for the customer order need to be
cancelled and the customer needs to be notified that the ordercould not be fulfilled.

You create a partial XLANG schedule drawing to represent the business process as shown
in the exhibit.
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You need to complete the XLANG schedule by configuring the correct transaction for the
required business process. What should you do?

A. Place a Transaction shape over the While shape and all actions on either side of the While
shape.

Select Timed transaction as the transaction type.

In the Transaction Properties dialog box, click the Add Code button and select the Enagled
check box.

B. Place a Transaction shape over the Update ERP Database and Send POto supplier shapes.
Select Short-lived, DTC-sytle as the transaction type.

In the Transaction Properties dialog box, click the Add Code button and select the Enabled
check box.

Add actions and implementations in the On failure tab to flag the purchase orders and sales
order in the ERP database as cancelled, to send a cancellation notification to the suppliers, and to
send a notification to the customer.

C. Place a Transaction shape over the While shape and all actions on either side of the While
shape.

Select Long running as the transaction type.

In the Transaction Properties dialog box, click the Add Code button and select the Enabled
check box.

Add actions and implementations in the On failure tab to flag the purchase orders and sales
order in the RRP database as cancelled, to send a cancellation notification to the suppliers, and to
send a notification to the customer.

D. Place a Transaction shape over the While shape and all actions on either side of the While
shape.

Select Long running as the transaction type.

In the Transaction Properties dialog box, click the Add Code button and select the Enabled
check box.

Add actions and implementations in the On failure tab to flag the purchase orders and sales
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order in the ERP database as cancelled, to send a cancellation notification to the suppliers, and to
send a notification to the customer.
Select Serializable as the isolation level.

Answer:

QUESTION 17:

You are a BizTalk Server developer for Certkiller . Certkiller uses BizTalk Server 2000 to
receive purchase

orders from a trading partner. BizTalk Server 2000 processes the purchase order and
submits invoices to the trading partner.

You design the XLANG schedule drawing shown in the exhibit to accomplish these tasks.
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[Proce_ss Qrder = || PoesssCnder_out? T ProcessOrder
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Submilinvoice — MessageQueuing
Submitinvoice Arivets \_Sub

Certkiller recently agreed to receive purchase orders from another trading partner. You
need to modify the XLANG schedule to process purchase orders for both trading partners.
You want to use one orchestration port send to invoices to different message queues.

How should you configure the properties of the Message Queuing shapes?

A. Configure the GetOrder port as Static.

B. Configure the Submitinvoice port as Static.

C. Configure the GetOrder port as Dynamic.

D. Configure the Submitinvoce port as Dynamic.

Answer:

QUESTION 18:
You are a BizTalk Server developer for a bank. The bank uses an XLANG schedule named

objProcess to process credit card transactions initiated by different credit card providers.
The properties of a Begin flowchart shape are shown in the exhibit.
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You need to set the transaction activation properties of the Begin shape to satisfy the
following business requirements:

If a client object that creates a new objProcess exists within the transaction context, the
objProcess should be part of the transaction context.

If a client object that creates a new objProcess does not exist within a transaction context,
the objProcess should not be part of the transaction context.

What should you do?

A. Set the transaction activation to Not Supported.
B. Set the transaction activation to Supported.

C. Set the transaction activation to Required.

D. Set the transaction activation on to RequiresNew.

Answer:

QUESTION 19:

You are a BizTalk Server developer for Certkiller . The company uses BizTalk Server 2000
for business-to-business (B2B) integration with a trading partner.

Certkiller 's current business process receives inbound documents from the trading partner.
Each inbound document contains one or more purchase order records and is temporarily
stored in a message queue. An XLANG schedule retrieves the document from the message
queue, and inserts the header and detail records into the enterprise resource planning
(ERP) database.

The trading partner wants to receive e-mail messages that contain any failed purchase
orders. You modify your XLANG schedule to incorporate this business requirement. You
add a new action named SendMail_ifErrorExists as shown in the XLANG Schedule
exhibit.
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The advanced port properties of the SendMail component are shown in the COM
component Binding Wizard exhibit.
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You investigate and discover that when you ran the test, a batch process was reading from
the ERP database. This batch process initiates every hour and can run as long as 10
minutes.

You need to correct the BizTalk Server 2000 configuration so that an e-mail messages is
sent whenever a purchase orderrecord fails to be inserted into the ERP database due to
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validation failure. What should you do?

A. Redraw the transaction box to exclude the SendMail_ifErrorExistsaction step.

B. Configure the back off time to more than 600 seconds and the retry count to a non-zero value
in the Transaction Properties dialog box.

C. Disable the transaction support property for the SendMail component is the COM Component
Binding Wizard.

D. Selection the On failure check box in the Transaction Properties dialog box and move the
SendMail_ifErrorExists action and its implementation to the On failure page.

Answer:

QUESTION 20:

You are a BizTalk Server developer for Certkiller . Certkiller uses BizTalk Server 2000 for
business process integration with one of its trading partners. Certkiller receives sales orders
from the trading partner's applications system.

Sales orders are received in XML format and are temporarily stored in a message queue.
These sales orders need to be loaded into Certkiller 's enterprise resource planning (ERP)
application. You develop a transactional COM component to read the Sales Order records
from the XML file and store them to the ERP database.

The orchestration process and other parts of your BizTalk Server configuration are shown
in the Business Process exhibit, the Method Communication Wizard exhibit, and the Data
exhibit.

- ssage Queui

Mo ReadSalesOrderPort 5

- -
rivate$iSales 1l
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InsertSalesOrder InserSOPort _clsUpdateDB
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Method Communication Wizard

Welcome to the Method
Communication Wizard
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InsertSOPort UpdateSO:clsUpdateDB

Your successfully compile the XLANG schedule. When you test the XLANG schedule, you

notice that the method implementing the InsertSalesOrder action was not invoked.

You need to ensure that the Insert SO method is invoked and that the sales orderrecords

are stored to the ERP database. What should you do?

A. Register the UpdateSO compo9nent by using regsvr32.exe.

B. Select the Initiate a synchronous method call option in the Method Communication wizard.
Compile the XLANG schedule again.

C. Drag the data flow from Document field of the SalesOrder message to the Document field of
the InsertSO_out method on the Data page of the orchestration diagram.

D. Register the UpdateSO component as a COM+ application in Component Services. Select the
Supported option for Transaction Support on the Transaction tab.

Answer:

QUESTION 21:

You are a BizTalk Server administrator for Certkiller . You make extensive use of the
BizTalk Orchestration Service. You discover that some XLANG schedules are not
terminating correctly. You need to terminate all XLANG schedules that are currently
running.
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What are two possible ways to terminate all XLANG schedules that are currently running?
(Each correct answer presents a complete solution. Choose two.)

A. Restart each BizTalk Server computer in the BizTalk Server group.

B. Create a Windows Script Component that uses the group manager object to iterate over all
running schedules.

C. Use the XLANG Scheduler in Component Services.

D. Use Services and Applications in the Computer Management console.

E. Use BizTalk Document Tracking.

F. Use BizTalk Server Administration.

Answer:

QUESTION 22:

You are the BizTalk Server administrator for a large online reseller. Certkiller wants to be
BizTalk Server 2000 to retrieve purchase orders electronically and route each purchase
order into an existing order fulfillment system.

The existing order fulfillment system is capable of importing comma-delimited ASCI| files.
Certkiller 's developers provided document definitions that describe the ASCII format
accepted by the order fulfillment application. You configured a system that allows
customers to submit purchase orders to a URL on your server.

To support the current order fulfillment system, you need to configure your BizTalk

Server computer to route all incoming orders as individual files to a folder named Orders.
What should you do?

A. Configure a port to use a File transport service and specify the desired folder and file name
as:

File://c:\Orders\PurchaseOrder&tracking_id&.txt

B. Configure a port to use a File transport service and specify the desired folder as:

File: //C:\Orders\

C. Configure a port to use a File transport service and specify the desired folder and file name as:
File://C:\Orders\PurchaseOrder&datetime&.txt

D. Configure a portuse a File transport series and specify the desired folder and file name as:
File://c:\Orders\purchaseOrder.txt

Answer:

QUESTION 23:

You are the BizTalk Server administrator for Certkiller . You maintain a large
business-to-business (B2B) system that uses BizTalk Server 2000 for communications with
Certkiller 's trading partners. One of your trading partners uses this system to route
information to Certkiller in ASCII format. You use the BizTalk Messaging Service to
transform each received document into your internal message format.

Your manager now requires you to log the original document your receive. You need to
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change your configuration of BizTalk Server 2000 to accommodate this requirement.
What should you do?

A. Configure the utilized channel to log the inbound document in native format.

B. Create an application integration component (AIC) to log the inbound document.

C. Configure the utilized channel to log the inbound document in XML format.

D. Configure the utilized document definition to track all the required fields of the inbound
document.

Answer:

QUESTION 24:

You are the BizTalk Server administrator for Certkiller . The management at Certkiller
Wants to use BizTalk Server 2000 to submit documents to trading partners. The
documents are to be received from an internal financial application.

In order to post the financial application documents to a place where BizTalk Server 2000
can retrieve them, Certkiller 's development team wants you to configure a message queue.
The document information to be transmitted does not require roolbacks. It is critical that
messages are never lost.

You need to configure your BizTalk Server computer to support these requirements. What
should you do?

A. Create an nontransactional queue.

Create a port that uses a Message Queuing primary transport by using the queue name and
location as the address.

Provide the development team with the appropriate name and location of the queue.

B. Create an nontransactional queue.

Use a Message Queuing receive function to post the message to BizTalk Server 2000.
Provide the development team with the appropriate name and location of the queue.

C. Create an nontransactional queue.

Create a port that uses a Message Queuing primary transport by using the queue name and
location as the address.

Provide the development team with the appropriate name and location of the queue.

D. Create an nontransactional queue.

Use a Message Queuing receive function to post the message to BizTalk Server 2000.
Provide the development team with the appropriate name and location of the queue.

Answer:

QUESTION 25:

You are a BizTalk Server administrator for Lucerne Publishing. Certkiller receives invoices
from different vendors, such as paper suppliers. The vendors use self-routing documents.
BizTalk Server 2000 is configured to use self-routing documents for invoice transactions.
The document specification is shown in the Document Specification exhibit.
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2 Microscft Internet Explorer
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You have a new supplier named Wide World Importers. An example of an invoice from

Wide World Importers is shown in the Sample Invoices exhibit.
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You need to reconfigure the existing BizTalk Server 2000 configuration of your home
organization to support Wide World Importers transactions. What should you do?

A. Set the Qualifier property to LucernePublishing and the Value property to 799.
B. Set the Qualifier property to 799 and the Value property to LucernePublishing.
C. Set the Qualifier property to Wide WroldImporters and value property to 9345.
D. Set the Qualifier property to 9345 and the Value property to WideWorldImporters.

Answer:

QUESTION 26:

You are the BizTalk Server developer for Certkiller . Certkiller uses BizTalk Server 2000 to
integrate its business processes with multiple trading partners by using HTTP and HTTPs.

Certkiller has a new trading partner. This new partner plans to use e-mail as its transport

mechanism. This partner needs to receive positional flat-file formats in a specific document

schema that the partner will provide.

You plan to use the same self-routing message formats, including document type and
organization names that are configured with Certkiller 's current trading partners.
You need to add the new trading partner to the current configuration of your BizTalk
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Server computer while supporting the new trading partner's requirements.
Which action or actions should you take? (Choose all that apply.)

A. Configure the SMTP host on your BizTalk Server group.

B. Create an envelope and apply it on the port that is being used.

C. Create a new channel and a new port that has an open designation.

D. Create a new channel and a new port for the new trading partner.

E. Configure the reliable messaging reply-to URL on your BizTalk Server group.
F. Create a new channel linked to an existing port.

Answer:

QUESTION 27:

BizTalk Server 2000 to integrate its business processes with multiple trading partners by
using HTTP and HTTPS.

Certkiller has a new trading partner. This new partner plans to use e-mail as its transport
mechanism. This partner needs to receive positional flat-file formats in a specific document
schema that the partner will provide.

You plan to use the same self-routing message formats, including document type and
organization names, that are configured with Certkiller 's current trading partners.

You need to add the new trading partner to the current configuration of your BizTalk
Server computer while supporting the new trading partner's requirements.

Which action or actions should you take? (Choose all that apply.)

A. Configure the SMTP host on your BizTalk Server group.

B. Create an envelope and apply it on the port that is being used.

C. Create a new channel and a new port that has an open destination.

D. Create a new channel and a new port for the new trading partner.

E. Configure the reliable messaging reply-to URL on your BizTalk Server group.
F. Create a new channel linked to an existing port.

G. Create a document map and apply it on the channel that is being used.

Answer:

QUESTION 28:

You are a BizTalk Server administrator for Certkiller . Certkiller wants to use BizTalk
Server 2000 to receive confidential information from all its trading partners. You need to
ensure that the senders of transactions are identified in order to guarantee the authenticity
of transactions. You plan to use existing certificates to achieve this goal.

You need to configure the BizTalk Server computer to verify all inbound transactions for
authenticity.

What should you do?

A. Configure all channels to verify the signature certificate against each trading partner's
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certificate.

B. Configure all channels to verify the signature certificate against Certkiller 's certificate.
C. Configure all channels to verify the encryption certificate against each trading partner's
certificate.

D. Configure all channels to verify the encryption certificate against Certkiller 's certificate.

Answer:

QUESTION 29:

You are a BizTalk Server administrator for Certkiller . Certkiller recently received a new
XDR schema from a trading partner. You import this schema by using BizTalk Editor and
save it as C:\Schema\Mychema.xml.

You need to create a new document definition for Myschema.xml. When you attempt to
create the new document definition, you can locate all existing schemas except
myschema.xml by using the Document Definition Properties dialog box.

You need to locate Myschema.xml by using the Document Definition Properties dialog box.
What should you do?

A. Stop and restart the BizTalk Services.

B. Open Myschema.xml by using BizTalk Editor and store it on WebDAV.

C. Open Myschema.xml by using BizTalk Editor. Export the schema to XDR format and save it
as C:\Myschema\Schema.xml.

D. Run lisreset.exe on the BizTalk Server computer.

Answer:

QUESTION 30:

You are the BizTalk Server administrator for Certkiller . You need to add a new trading
partner to your BizTalk Server computer. The new trading partner uses a
business-to-business (B2B) system that is based on electronic data interchange (EDI).

The new trading partner plans to route product price adjustments to your on an ongoing
basis. The trading partner plans to route product price adjustments to your on an ongoing
basis. The trading partner wants Certkiller to send receipts every time your BizTalk Server
computer successfully receives and processes an inbound document.

You need to configure the interchange to achieve reliable messaging. Which action or
action should you take? (Choose all that apply.)

A. Select the Expect receipt check box for the channel that is used to receive the inbound
document.

B. Select the Generate receipt check box for the channel that is used to receive the inbound
document.

C. Create a channel that is decimated to sending receipts.

D. Select the This is a receipt channel check box for he channel that is used o sent the receipt
E. Log the inbound document in native format.
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F. Track the entire inbound interchange.

Answer:

QUESTION 31:

You are the BizTalk Saver administrator for Certkiller . You maintain business-to-business
(B2B) interchanges between your bank and several thousand customers. The number of
customers is changing constantly as hundreds of customers are ads or removed on a daily
basis.

Certkiller maintains a database of customers in a mainframe-based financial application.
This application can export information that is to be sent to customers into XML messages
that are submitted to the BizTalk Server routing engine. The XML message contains either
the URL or the e-mail address, including the appropriate protocol, of the customer in a
field named Customer. The field is identified in the schema as a routing field.

You want to configure your BizTalk Server computer to accommodate a constantly
changing group of customers without having to change the setup every time a customer is
adds or removed. What should you do?

A. Create a distribution list and a new channel and link the channel to the list.

Verify that the document submission specifies the appropriate destination.

B. Create an open channel from the financial application and a port to an organization.
Configure the document submission to use open sources.

C. Create a channel from the financial application and an open port to an organization.
Configure the document submission to use open destinations.

D. Create a channel from the financial application and an open port to an organization.
Verify that the document submission specifies the appropriate destination.

Answer:

QUESTION 32:

You are the BizTalk Server developer for Certkiller . Certkiller uses an accounting
application that can export invoices as ASCII files. You wan BizTalk Server 2000 to
automatically route these newly created invoices to each of several trading partners. You
do not have source code or any other option to configure the accounting application to
communicate with BizTalk Server 2000.

You need to configure BizTalk Server 2000 to retrieve the output created by the accounting
application and route it to the appropriate destination. You need to accomplish the goad
with the least amount of development effort.

You create a channel and port combination for each trading partner. What else should you
do?

A. Obtain and deploy an application integration component (AIC) that retrieves and converts the

files into a format that compiles with current document definitions and submits it to the BizTalk
Server 2000 routing engine.
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B. Obtain and deploy an application integration component (AIC) that retrieves and converts the
files into a format that complies with current document definitions and submits its to the BizTalk
Server 2000 routing engine.

C. Create a File receive function that monitors a directory for newly exported ASCII files.
Specify an envelope.

D. Configure the ports to use the File transport service to post documents to BizTalk Server
2000.

Specify an envelope.

Specify the directory that the account application uses as the transport address.

Answer:

QUESTION 33:

You are a BizTalk Server developer for Certkiller . Certkiller uses BizTalk Server 2000 for
enterprise application integration (EAI) to integrate its purchasing application with its
accounts payable application. At the end of each day, the purchasing application
downloads a list of items received from the trading partners and the trading partner who
sold the items. The list is in flat-file format. The accounts payable application requires this
information to inmate the payment process. A sample of the flat file is as follows.

Po011, vend023, Anthony Dowler, hard drive, 12, 2395.00

P0022, vend012, Laura Jennings, server machine, 3, 14995.00

You create a document specification for the flat file as shown in the exhibit.
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Ble Edit Mew Iooks  Help
DV W [0 o [ B K[ ™ B B [P T
(=) J Ejiﬂg‘gﬁﬁmfd*' Declaration | Palerence  Parse | Mamespace | Dictionary | Code List
- ;ﬂ POMurmber E’rotpe:lyc I | Yeke.
il VerdorCods HEDM L 2L
g Custarm Date/T e Format

u) Contacthame Justification Left

i Itamr-h:;mbar Pad Charaetst SPACE (020 )

] Cuaritity WhapCharsete

I ExterdedPrios Minirum Lergth With Pad Character

« 2

You successfully validate the sample file by using BizTalk Editor. Next, you attempt to
validate the following sample data file.

Po011, vend023, "Jones, Amy", hard drive, 12, 2395.00

P0022, vend012, "Lugo, Jose", servermachine, 3, 14995.00

You receive the following error message.

Description:

An error occurred in BizTalk Server.

Details:

While parsing record "PurchaseOrder", the parser cannot find the required delimiter:

" (0x000a).
The parser failed to convert the document due to processing errors. See the following
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messages for details.

While trying to process document #0 during submission
"{D570A284-33D5-4AA7-BOFE-DB1D7E115838}", the parser component named
"BizTalk. ParserFFile.1" failed on the method "GetInterchangeDatails" with the error
code "0xc0c01433". Possible causes are: the component found unexpected data in the
incoming stream; a document specification could not be found given the data; or an
internal component failure occurred. If this problem continues, remove this component
from the valid list of parser components or contact your system administrator.
Suspended Queue ID: "{72478117-813D-4275-B42C-3A9141F39D07}"

The parser failed to convert the document due to processing errors.

You need to process the document successfully. You also need to provide a permanent
solution that ensures the integrity of the original data.

What should you do?

A. On the Parse tab for the PurchaseOrder record, set the Escape Type property to Character and
Escape Value property to the following.

" (0x22)

B. On the Parse tab for the ContactName field, set the Wrap Character property to the following:
" (0x22)

C. Write a custom preprocessor that can replace the comma character in the ContactName field
with any unused character.

Process the sample file by using this preprocessor and then submit the file to BizTalk Server
2000.

D. On the Parse tab for the PO record, set the Field Order property to Infix.

Answer:

QUESTION 34:

You are a BizTalk Server developer for Certkiller . You are creating a map that converts
payroll data between the XML format used by the human resources department and the
flat-file format used by the payroll department. You develop a function script that you
need to validate.

You need to use the BizTalk Server XML tools to enter sample data to validate the script.
What should you do?

A. Enter the sample data in the Source test value text box on the Values tab of BizTalk Mapper
and select Test Map from the Tools menu in BizTalk Mapper.

B. Enter the sample data in the Destination constant value text box on the Values tab of BizTalk
Mapper and select Test Map from the Tools menu in BizTalk Mapper.

C. Enter the sample data in the Data Type Values property on the Declaration tab of BizTalk
Editor and select Test Map from the Tools menu in BizTalk Mapper.

D. Import a sample XML file containing the sample data into BizTalk Editor.

Answer:
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QUESTION 35:

You are a BizTalk Server developer for Coho Vineyard. You are creating a BizTalk Server
system that receives shipping notices from your bottle supplier, then converts them into
Certkiller 's internal XML format.

The shipping notice format used by the bottle supplier contains a complex product code.
The first part is manufacturer code, which consists of letters. The second part is a bottle
type code, which consists of digits. You need to separate these parts into different fields in
the XML file.

You want to perform this task by using BizTalk Mapper, and you want to use the least
amount of development effort. What should you do?

A. Create a COM component that returns both fields.

Call the COM component from a Scripting functiod.

B. Create a Scripting function that contains two variables.

Write Script to store the manufacturer code in one variable and the bottle type code in the other
variable.

C. Crate a Scripting function that separates the manufacturer code from the bottle type code.
Pass the output to the VValue Mapping functiod.

D. Create two Scripting functoids.

Configure one Scripting functoid to return the manufacturer code, and configure the other
Scripting functioned to return the bottle type code.

Answer:

QUESTION 36:

You are a BizTalk Server developer for Certkiller . Certkiller 's accounting department is
sending data to the human resources (HR) department by using BizTalk Server 2000. To
follow new company standards, you need to reconfigure a schema named
EmployeeData.xml for self-routing.

You configure organization identifiers for the account department and the HR department
as shown in the Organization Properties exhibit.

Organization Properties
General  knifiers | Applizations |

Crganization identification
MName | Gisliher | value
Organization [Default])  Organization™..  Home Organiz...

HA Depatment il ] 1
Accounting Department 88 2

T R R

Routing information is included inside of the Address element as shown in the Routing
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Information exhibit.
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You need to modify the Dictionary property of the Address element for self-routing by
using BizTalk Editor. What should you do?

A. Configure the Source Type to ./Address/department2ID.
Configure the Source Value to ./Address/Department2.
Configure the Destination Type to. /Address/Departmentl1ID.
Configure the Destination value to ./Address/Department1.
B. Configure the Source Type to ./Address/Departmentl.
Configure the Source Value to ./Address/Department1ID.
Configure the Destination Type to ./Address/Department?2.
Configure the Destination value to ./Address/Department2ID.
C. Configure the Source Type to ./Address/Department2.
Configure the Source Value to ./Address/Department2ID.
Configure the Destination Type to ./Address/Department1.
Configure the Destination value to ./Address/Departmentl1ID.
D. Configure the Source Type to ./Address/Departement?2.
Configure the Source Value to ./Address/Department2ID.
Configure the Destination Type to ./Address/Departmentl1ID.
Configure the Destination Value to ./Address/Departmentlid.

Answer:

QUESTION 37:

You are a BizTalk Server developer for Certkiller . You are using BizTalk Mapper to
develop a schema to convert x 12 850 purchase orders to an XML format. Certkiller uses
several different purchase order formats. The company uses an attribute named
Documents Type in the root node to find out which format is in use.

You want to assign the value PO2001.3 to the Document Type Attribute with the lest
amount of development effort. What should you do?
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A. Create a custom function in Microsoft Visual Basic by implementing the CannedFunctiod
interface.

Configure the functiod in BizTalk Mapper to return the value PO2001.3.

B. Create a Scripting functoid in BizTalk Mapper that returns the value PO2001.3.

C. Use the Concatenate functiod in BizTalk Mapper to return the value PO2001.3

D. Type PO2001.3 in the Destination constant value text box on the Values tab of BizTalk
Mapper.

Answer:

QUESTION 38:

You are a BizTalk Server developer for Certkiller . Certkiller is in the process of integrating
a sales orderentry application with an accounts receivable application. You need to
configure periodic synchronization of customer name and address details in the sales
orderentry application with the customer name and address details in the accounts
receivable application.

The Accounts receivable application can generate customer name and address details as a
flat file with a carriageOreturn character as the record delimiter. Fields are delimited by

the character sequence #-#.

The following is a sample output file containing six fields.

100000#-#Nash, Mike#-#5643-Kobara Street #-#Sunnyvale#-#CA#-#044-12982353
100001#-# Barbariol, Angela # -# 34534, Sun Street # - # Sunnyvale # CA# - # 049-12987234
100003#-# Chai, Sean# - # 5743, EIm Street, #23# - # Chicago # - # 045-34562534

The Sale orderentry application can accept data in XML format from a message queue.

You need to configure BizTalk Server 2000 to read and validate the flat file generated by
the Accounts receivable application and send the file to a predefined message queue. You
need to ensure the integrity of the data during this process.

What should you do?

A. Define a schema specification by using an unused data character as a field delimiter.

Create a document definition for this schema.

Configure a channel and port combination to use this document definition to transform the
customer details document into XML format and to send it to the message queue.

Configure a File receive function to poll for inbound flat files that contain customer details and
call the configured channel.

B. Define a schema specification by using the following as a field delimiter:

, (0x2c)

Create a document definition for this schema.

Configure a channel and port combination to use this document definition to transform the
customer details document into XML format and to send it to the message queue.

Configure a File receive function to poll for inbound flat files that contain customer details and
call the configured channel.

C. Define a schema specification by using the following as a field delimiter:

# (0x23)

Create a document definition for this schema.
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Configure a channel and port combination to use this document definition to transform the
customer details document into XML format and to send it to the message queue.

Configure a File receive function to poll for inbound flat files that contain customer details and
call the configured channel.

D. Develop a custom preprocessor component that replaces each comma with a space character
and the string #-# with a comma character.

Configure a File receive function to use this preprocessor component.

Define a schema specification by using the following as a field delimiter.

, (Ox2c)

Create a document definition for this schema.

Configure a channel and port combination to use this documents definition to transform the
customer details document into XML format and to send it to the message queue.

Configure a File receive function to poll for inbound flat files that contain customer details and
call the configured channel.

E. Develop a custom preprocessor component that replaces the string #-# with an unused data
character.

Configure a File receive function to use this preprocessor component.

Define a schema specification by using this unused character as a field delimiter and crate a
document definition for this schema.

Configure a channel and port combination to use this document definition to transform the
customer details document into XML format and to send it to the message queue.

Answer:

QUESTION 39:

You are a BizTalk Server developer for Certkiller . Certkiller uses BizTalk Server 2000 to
configure business-to-business (B2B) integration with one of its trading partners.
Certkiller 's purchasing application is being configured to download data to XML format
only. However, your trading partner requires purchase orderdocuments to be received in a
positional flat-file format. Certkiller agrees to handle the purchase order transformations to
meet the trading partner's requirement.

You crate the schema specification and are setting up BizTalk Messaging Manager to
handle the data transformation and transportation. Your trading partner is configuring its
B2B integration to receive and process purchase order. The trading partner requests a
sample data file so that it can conduct preliminary testing of the configurations on both
sides. However, Certkiller 's purchasing application is net ready to download purchase
order documents in XML format.

You need to send a sample output file from BizTalk Server 2000 to your trading partner.
Which two courses of action should you take? (Each correct answer presents part of the
solution. Choose two.)

A. Open the specification in BizTalk Editor and select Create XML Instance from the Tools
menu.
B. Open the specification in BizTalk Editor and select Export XDR Schema from the Tools
menu.
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C. Create a document definition and a flat file envelope by using the specification.
Configure a port with a File transport type to use this envelope.

Configure a channel to use this document definition.

Submit the XML document to the channel.

D. Create a document definition and a flatfile envelope by using the specification.

Configure a port.

Configure a channel to use this document definition.

Programmatically submit the XMI document to the channel, and use the envelope name as a
parameter.

E. Create a document definition and a custom envelope by using the specification. Configure a
port.

Configure a channel to use this document definition.

Programmatically submit the XML document to the channel, and use the envelope name as a
parameter.

Answer:

QUESTION 40:

You are a BizTalk Server developer for Certkiller . Certkiller is in the process of
business-to-business (B2B) integration with a trading partner. Both companies agree to use
BizTalk Server 2000 for the B2B integration.

Certkiller will send all purchase order documents to the trading partner by using BizTalk
Server 2000. You need to crate a schema to validate each XML purchase order file received
by BizTalk Server 2000 from Certkiller 's purchase order application. You need to configure
the schema specification to include only those fields that are contained in the purchase
order.

You need to perform this task with the least amount of administrative effort. What should
you do?

A. Use the New option on the File menu in BizTalk Editor and select Blank Specification.
Crate records and fields based on the data from the XML purchase order file.

B. Use the New option on the File menu in BizTalk Editor and select Blank Specification.
On the Reference tab, change the Standard property value to Custom.

Cratre records and fields based on the data from the XML purchase order file.

C. Use the New option on the File menu in BizTalk Editor and select X12.

Select the appropriate version of the 850 Schema.xml file.

Remove the fields that are not present in the XML purchase order file.

D. Use the Import option on the Tools menu in BizTalk Editor and select Well-formed XML
Instance.

Use the XML purchase order file as input.

Modify the schema specification to define the data type and the fields length properties.

Answer:

Actualtests.com - The Power of Knowing




070-230

QUESTION 41:

You are a BizTalk Server developer for Certkiller . You are modifying a map that was
created by another developer. A field on the destination specification has no links going
into it. When you attempt to drag the output from a Concatenate functoid into the field, no
link appears. No message box is displayed in response to your action.

What is the most likely cause of this problem?

A. The field type is integer value, and the field cannot accept a string.

B. The length of the output fields is less than the total length of the concatenated input fields.
C. The output field is marked as the Source Value property on the Dictionary tab of BizTalk
Editor.

D. A value is set for the field in the Destination constant value text box on the Values tab of

BizTalk Mapper.

Answer:

QUESTION 42:

You are the BizTalk Server architect for Certkiller . Certkiller uses enterprise resource
planning (ERP) applications to support its current operations. The general ledger,

accounts payable, accounts receivable, and management accounting applications are
categorized as logistics applications.

BizTalk Server 2000 is being deployed throughout the company to integrate the business
processes of all these applications. One BizTalk Server group will consist of one computer
integrating the financial application. Another BizTalk Server group will consist of one
computer integrating the logistics applications. Document tracking is required for all
inbound and outbound interchanges.

You need to design the database architecture for the BizTalk Server groups so that you can
administer both BizTalk Server groups from any server in either BizTalk Server group. In
addition, you need to configure the architecture for optimal performance and scalability.
What should you do?

A. Configure a Tracking database and a Shared Queue database for each BizTalk Server group.
Configure a simple BizTalk Messaging Management database for both BizTalk Server
Messaging.

B. Configure a Tracking database, a Shared Queue data base, and a BizTalk Messaging
Management database for each BizTalk Server group.

C. Configure a Tracking database and a BizTalk Messaging Management database for each
BizTalk Server group.

Configure a Shared Queue database for one BizTalk Server group, and configure the other
BizTalk Server group to point to this Shared Queue database.

D. Configure a simple BizTalk Messaging Management database, a single Shared Queue
database, and single tracking database for both BizTalk Server groups.

Answer:
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QUESTION 43:

You are a BizTalk Server developer for Certkiller . Certkiller wants to use BizTalk Server
2000 to receive electronic invoices from one of its trading partners. The security group at
the trading partner informs you that they will open their firewall for outbound
communication thought TCP port 80 only.

You need to design a BizTalk Server solution to receive electronic from this trading
partner. What should you do?

A. Use the BizTalk Messaging Manager to create a port that uses the HTTP transport type.

B. Use the BizTalk Messaging Manager to crate a port that uses the File transport type.
Associate a File receive function with the ports's file folder.

C. Create an ASP page to receive each invoice and call theSubmit method of the lInterchange
interface.

D. Crate an ASP page to receive each invoice and call the Submit method of the lInterchange
interface.

Configure your Web site to accept HTTP communications.

Answer:

QUESTION 44:

You are a BizTalk Server developer for Certkiller . You are crating a BizTalk Server
solution to receive X 12 856 shipping notices. You have a connection to a value-added
network (VAN) that saves incoming shipping notices in a file folder. To minimize
communication costs, the trading partner sending the shipping notices will compress the
X12 files to a binary format.

You need to crate a comonent that decompresses the X12 files. You want to accomplish this
task with the least amount of development effort.

What should you do?

A. Build a component that implements the IbizTalkParserComponent interface.
Use the component as a custom parser in a File receive function.

B. Build a component that implements the IBTSCustomProcess interface.

Use the component as a custom preprocessor in a File receive function.

C. Build a component that implements the ISchmalmporter interface.

Use the component to import the compressed files into BizTalk Editor.

D. Build a component that implements the IFunctoid interface.

Use the component to map the compressed X12 data to XML in BizTalk Mapper.

Answer:

QUESTION 45:

You are the BizTalk Server administrator for Certkiller . Your BizTalk Server computer
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runs a variety of XLANG schedules. After discovering a bug in one of the schedules, you
use BizTalk Orchestration Designer to modify and recompile the schedule. You then
redeploy the schedule to the production servers.

What is the most likely impact of the change?

A. Schedules that are already running will be updated immediately.

Schedules that are started after the change will use the new version.

B. Schedules that are already running will continue to use the previous version.

Schedules that are started after the change will use the new version.

C. Schedules that are already running will be updated after they are dehydrated and redrafted.
Schedules that are started after the change will use the new version.

D. Schedules will continue to use the previous version until the COM+ application running the
schedule is restarted.

Answer:

QUESTION 46:

You are a BizTalk Server developer for Certkiller . You create a Microsoft Visual Basic
COM component that submits purchase orders to your BizTalk Server computer. The
purchase order documents are in XML format. No receive functions are configured on this
server.

You want to ensure that only users in the purchasing department can submit purchase
order documents to the BizTalk Server computer.

You crate a group on the BizTalk Server computer. The group represents users in the
purchasing department.

What else should you do?

A. Add the group to the BizTalk Server Administrators group on the BizTalk Server computer.
Remove any other users and groups from the BizTalk Server Administrators group.

B. Create a Microsoft SQL Server logging for the group by using SQL Enterprise Manager.
Configure InterchangesSQ as the default database for the login, and make the login a member of
the Db_datawriterdatabase role.

Ensure that no other group has permissions on this database.

C. Add the group to the BizTalk Server Report Users group on the BizTalk Server computer.
Remove any other users and groups from the BizTalk Server Report Users group.

D. Use Component Services to enable roe-based security for the BizTalk Serverinterchange
Application.

Add the group of users in the purchasing department to a role on the BizTalk Server
Interchange Application, and associate the role with the Submit and SubmitSync methods of the
lInterchangeinterface.

Answer:

QUESTION 47:
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You are the network administrator for Certkiller . You administer a BizTalk Server group
that uses the BizTalk Messaging Service to receive purchase orders in a variety of formats
form a large number of trading partners. These documents need to be tracked.

Purchase orders are received by an ASP page. The ASP page uses the Submit method of
the lInterchange interface to send them to BizTalk Server 2000. There is little use of
XLANG schedules. The BizTalk Server group has a single database server that supports
the BizTalk Messaging Management database, the Shared Queue database, the Tracking
database, and the Orchestration Presistence database. When you run System Monitor on
the database server, you notice that the CPU usage is almost 100 percent.

You add a second, identical database server to the BizTalk Server group. You need to
distribute the database load across the two servers.

What should you do?

A. Leave the BizTalk Messaging Management database and the Orchestration Persistence
database on the original server.

Move the Shared Queue database and the Tracking database to the new server.

B. Leave the BizTalk Messaging Management database on the original server.

Move the Shared Queue database, the Orchestration Persistence database, and the Tracking
database to the new server.

C. Leave the BizTalk Messaging Management database the Shared Queue database and the
Tracking database on the original server.

Move the Orchestration Persistence database to the new server.

D. Leave the BizTalk Messaging Management database, the Orchestration Persistence database,
and the Shared Queue database on the original server.

Move the Tracking database to the new server.

Answer:

QUESTION 48:

You are a BizTalk Server architect for Certkiller . Certkiller supplies automibile spare parts
to its trading partners. Certkiller wants to use BizTalk Server 2000 to intergrate your sales
ordersystem with your trading partners' purchase order systems. The trading partners

agree to use HTTP to send purchase order (PO) documents to your Web server.

A single Internet Information Serives (11S) server hosts Certkiller 's Web site. BizTalk
Server 2000 is also installed on this server. BizTalk Server 2000 is connected to a different
computer that is running Microsoft SQL Server.

Wishout

adding hardware, you need to design your BizTalk Server 2000 installation for maximum
reliability. What should you do?

A. Design an XLANG schedule that takes the PO documents from a receive ASP page and
processes them.

Configure the Connection Timeout in 11S to more than 900 seconds.

B. Design a receive ASP page to store the PO documents in a message queue.

Define a Message Queuing receive function to process the documents from the queue.
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C. Design a receive ASP page to receive the PO documents.

Use the SubmitSyncmethod of the linterchange to post the document to BizTalk Server 2000
from the ASP page.

D. Design a receive ASP page to receive the PO documents.

Use the Submit method of the lInterchange interface to post the document to BizTalk Server
2000 from the ASP page.

Answer:

QUESTION 49:

You are a BizTalk Server developer at Certkiller 's main office. Certkiller has many
manufacturing facilities across the country. The manufacturing facilities are grouped into
independently operated zones.

At he end of each day. All zones send their daily cash-flow information to a cash-flow
application at the main office in a flat-file format. Using BizTalk Server tools, management
wants to track only those cash-flow amounts that are higher than a particular dollar

amount specified by management. The amount should be configurable after deployment by
using the configuration options in BizTalk Server 2000. Such transactions would then need
to be sent to the ach-flow application.

You need to develop a BizTalk Server solution to meet these requirements. What should
you do?

A. Create an application integration component (AIC) that receives the document that contains
the cash-flow information, and send the document to the cash-flow application.

Implement the IpipelineComponent interface in the AIC.

Define a port by using this AIC as the transport type and define a channel for the port.

Define a File receive function that polls for cash-flow documents and invoke this channel.

B. Create an application integration component (AIC) that receives the document that contains
the cash-flow information, and send the document to the cash-flow application. Implement the
IBTSApplntegrationinterface in the AIC.

Define a port by using this AIC as the transport type and define a channel for the port.

Define a File receive function that polls for cash-flow documents and invoke this channel.

C. Create a COM component that receives the document that contains the cash-flow information,
and send the document to the cash-flow application.

Define an XLANG schedule that calls this component.

Define a port that uses XLANG Scheduler as the transport type and define a channel for the
port.

Define a File receive function that polls for cash-flow documents and invoke this channel.

D. Use the BizTalk Scriptor to develop an application integration component (AIC) to receive
the document that contains the cash-flow information and send the document to the cash-flow
application.

Define a port by using this AIC as the transport type and define a channel for the port. Define a
File receive function that polls for cash-flow documents and call this channel.

Answer:
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QUESTION 50:

You are a BizTalk Server developer for a company.. The company's trading partner sends
purchase order (PO) documents in a delimited flat-file format to your FTP server. At the
top of each flat file, the format of data for that file is treated as data.

Each PO has a PO header and line item details data segments. The format is shown in the

exhibit.

& pofile.tst - Notepad M= B
Fie Edt Format Help

HSTART =

PonNumber , Fonate, suppliername, supplierphone, supplierFax, TotalnumberofLinertems
Linertemno, Itembescription, Quantity,voiceedto, DeliveryDate, wappMOUSE
HEND

WWIPOOOL,10,/10/2001, wide world Importers, 044-1234432, 044-1234431,2
WwWI-LI001, Keyboard,230,380.95,11,/11/1001, chicago

WwI-LT002,Mouse, 290,120,00,12,/12/2001, chicage

HEPODOL, 10/10,/2001, Northernd Traders,044-4324432,044-4324431,4
HBE~Iteml0l, Fen, 1000, 5.50,11,/11 /2001, Melbour ne

HB-Item&72, notepad, 1000,1.75,11,/11,/2001, MeT bourne

HE-TTem721, Paperclip,10000,0.45%,11,/11/2001, Mmelbourne

HE-Item239, stapler, 500,4.25,12/12,/2001,Me]bourne
WWIPO002,10/10/2001, wide wor1d Importers,044-1234432,044-1234431,3
WWI-.I1001, Keyboard, 230, 380, 95,11/11/1001, Chicago

eI~ 1002, Mouse, 290,120.00,12/12/2001,chicage

WwWI-LI003, Mouserad, 290, 25. 00,1212,/2001, chicago

H
You need to extract data from the inbound PO documents and submit the data to the
internal systems for further processing. What should you do?

A. Create a schema for processing inbound flat-file PO documents.

In BizTalk Server Administration, move BizTalk.ParserFFile.1 to the top of the Arrange the
server call sequence box.

B. Create a schema for processing inbound XML-based PO documents.

In BizTalk Server Administration, move BizTalk.ParserFFile.1 to the top of the Arrange the
server call sequence box.

C. Create a schema for processing inbound XML-based PO documents.

Create a custom serializer that serialized inbound files.

D. Create a schema for processing inbound flat-file PO documents.

Create a custom parser that parses inbound files.

Answer:

QUESTION 51:

You are a BizTalk Server developer for a shipping company. Certkiller wants to use
BizTalk Server 2000 for business-to-business (B2B) transactions with its customers.

You want to configure a system so that customers send purchase order

and shipment details to an FTP server located at Certkiller 's main office. You want the
shipment details to be inserted into a database. At the end of each day, you want the
BizTalk Server computer to extract shipment details from the database and send them to
static FTP addresses located at each branch office. The proposed configuration is shown in
the exhibit.
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You create an XLANG schedule to read shipment detail files and insert them into the
database. You create another XLANG schedule to extract and generate outbound files for
each branch office. You want these outbound files to be stored in separate message queues
that you create for each branch office.
You need to create a port and channel combination for each branch office. You also need to
create Message Queuing receive functions to send shipment detail files to each branch
office. You also need to ensure that FTP addresses at each branch office are configurable.
You need to provide a scalable solution with the least amount of development effort.
What should you do?

A. Choose File as the transport type and enter the valid local folder path for each branch office in
the Address box.

Create an application by using wininet.dll to use FTP send shipment detail files to each branch
office.

B. Develop a BizTalk Script or application integration component (AIC) that uses ftp.exe to send
the document.

Configure this AIC as the transport type in the messaging port.

C. Develop an application integration component (AIC) by implementing the
IBTSApplntegration interface.

Implement logic inside the AIC to use FTP to send the documents.

Configure this AIC as the transport type in the messaging port.

D. Develop an application integration component (AIC) by implementing the
IpipelineComponent interface.

Implement logic inside the AIC to use FTP to send the documents.

Configure this AIC as the transport type in the messaging port.

QUESTION 52:

You are a BizTalk Server developer for Certkiller . Your BizTalk Server computer receives
purchase orders from customers. The graphic shows a map that converts inbound

purchase order documents from one format to another format. You need to change the
constant that is stored in Item05 when the units of measurement (UOM) attribute is not a
number.

Which item in the map should you change?

To answer, click the appropriate item in the BizTalk Mapper dialog box.
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Answer:
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